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1 Introduction 
Allstream PC Communicator Desktop is a softphone that is easy to download 

from your Allstream PC account on to your Windows PC or laptop.   

Figure 1: Allstream PC Communicator Desktop 

The Allstream PC Communicator Desktop softphone provides a broad set of 
features that allow you to 

• make and receive audio calls directly from your computer, either using a
headset or your computer's inbuilt speakers and microphone

• make and receive video calls if your service provider has enabled the feature
and you have appropriate hardware

• view your call history

• maintain and manage a Contact list and, if you use Microsoft Outlook 2007 or
2010, synchronize this with your Outlook contacts

• access contact information from a corporate LDAP/Active Directory

• see how many new voicemail messages you have, and access your Allstream 
PC voicemail account at the click of a button

• integrate with third-party XMPP-based IM and Presence services such as
Jabber and Google Talk
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• configure Workgroups that allow you to monitor a set of lines in a Call Pickup
group, for example if you are a personal assistant who needs to have access to
your manager's line.

1.1 Using this End User Guide 

This guide will help you get up and running with Allstream PC 
Communicator Desktop as soon as possible.   

• Chapter 2 sets out what you will need to use Allstream PC 
Communicator Desktop, including the requirements for your PC or 
laptop.

• Chapter 3 explains how to download Allstream PC Communicator Desktop.

• Chapter 4 describes how to log on to Allstream PC Communicator Desktop.

• Chapter 5 describes how to use Allstream PC Communicator Desktop to 
check that your audio and video equipment is working correctly.

• Chapter 6 describes how to make calls using Allstream PC 
Communicator Desktop.

• Chapter 7 describes how to answer an incoming call.

• Chapter 8 describes how to access your Allstream PC voicemail account 
directly from Allstream PC Communicator Desktop.

• Chapter 9 describes how to access the extensive Help pages available with 
Allstream PC Communicator Desktop.

• Chapter 10 provides some basic troubleshooting information, and describes
how to generate Diagnostics Logging.

Once you have downloaded Allstream PC Communicator Desktop, you will have 
access to extensive Help pages that will guide you through all the features that the 
softphone offers. 

If after referring to this guide and the Help pages you're still having problems with 

downloading and using Allstream PC Communicator Desktop, then please contact 
your administrator. 
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2 What you will need 
Your Windows PC or laptop must have the following capabilities for you to use 

Allstream PC Communicator Desktop. 

Processor Intel Pentium 4 Processor, or, preferably, Intel Core 2 
Duo or equivalent 

Memory Minimum: 1 GB RAM  

Recommended: 2 GB RAM 

Hard Disk Space 50MB 

Operating system Windows XP Service Pack 3  

Windows Vista  

Microsoft Windows Vista Service Pack 1, 32-bits and 
64-bits architecture  

Microsoft Windows 7  

Connection IP network connection (broadband, LAN, wireless) 

Sound Card Full duplex, 16-bit, or use USB headset 

Video Card DirectX 9.0c support 

You will need both speakers and a microphone to make and receive calls.  You 
can use any of the following combinations.  However, we would recommend 
using a headset for optimal voice quality. 

• Dual-jack multimedia headset

• Bluetooth multimedia headset

• USB multimedia headset

• External speakers and microphone

• Built-in speakers and microphone

• USB phone.

If you want to make video calls, you will also need a webcam.  Allstream PC 
Communicator Desktop works with most USB video cameras.  You can still 
receive video calls if you do not have a camera on your PC but obviously won't be 
able to send video to the caller without one! 

You will need a web browser – either Internet Explorer 8+ or Firefox – and the 

phone number and password for your Allstream PC account. 
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3 Downloading Allstream PC 
Communicator Desktop 
To download Integra PC Communicator Desktop: 

• Log on to your Allstream PC account by pointing your browser 

at http://hostedvoice.integra.net.

• Enter your phone number and password.

• Select the Apps tab.

Figure 2:  Allstream PC Apps tab 

• Click the View Apps button.
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Figure 3: Allstream PC Communicator Desktop Download screen 

• Select Communicator from the menu in the left-hand side panel.

• Click the XP/Vista/Windows 7 link to download the installation package.

• A pop-up will appear on your screen.  Press Run to start installing Allstream 
PC Communicator Desktop.

• You may then see a security warning.  Press Run to continue with the
installation.

• You will then see a pop-up asking you to choose the language for Allstream 
PC Communicator Desktop.  If you are not using the default language, use 
the drop-down to select your language from the list of available languages.

• The Allstream PC Communicator Desktop Setup Wizard will then launch.  
This will guide you through the installation of Allstream PC Communicator 
Desktop.
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Figure 4: Allstream PC Communicator Desktop Setup Wizard 

• Click Next to start the wizard.

• Accept the End User License Agreement.

• Confirm the location on your computer where the files will be installed.

• Use the checkboxes to select whether

• a shortcut to Allstream PC Communicator Desktop is installed on 
your desktop

• the softphone is launched when Windows starts (recommended)

• a short cut should be created in Quick launch.

• Press Install to complete the installation.

• On the final screen, check or uncheck the box depending on whether you want 
to launch Allstream PC Communicator Desktop immediately, and press Finish.
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4 Logging on to Allstream PC 
Communicator Desktop 
You will log on to Allstream PC Communicator Desktop using the same 

phone number and password that you use to access your Allstream PC 

account. To log on to Allstream PC Communicator Desktop: 

• If you chose not to launch Allstream PC Communicator Desktop 
immediately when downloading it or when starting Windows, start the app 
by clicking on the  icon in your System Tray, or using the Windows Start 
button and selecting Allstream PC Communicator from the list of programs.

Figure 5:  Allstream PC Communicator Desktop Login screen 

• Enter the phone number you use to access Allstream PC in the Username field.

• Enter the password you use to access Allstream PC in the Password field.

• Check the boxes for Remember login information and Login automatically so 
that you do not need to log in each time Allstream PC Communicator 
Desktop starts up.

• If you are using Windows 7, you may see the following warning about your 
firewall settings the first time that you log in to Allstream PC 
Communicator Desktop.
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Figure 6: Firewall Warning 

• Tick all the boxes that apply.

• We recommend that you select all the network options, for example if you are
using a laptop and may also want to use your softphone when accessing public
networks.

• Click Allow access to save your settings.

• Allstream PC Communicator Desktop will now start.

We recommend that you now follow the instructions in chapter 5 to ensure that 
your audio and video equipment is connected and configured correctly. 
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5 Configuring and checking your 
audio and video equipment 
You should ensure that your audio and video equipment is configured correctly 

before you start using your Allstream PC Communicator Desktop softphone.   

You can use options on the softphone itself to run various checks to ensure that 
your equipment is working properly. 

5.1 Choosing your audio and video equipment 

First, you should decide which devices you want to use for audio calls. 

We recommend that you use a headset or separately attached microphone when 

making and receiving calls using Allstream PC Communicator Desktop because 
this will give the best audio quality.  However, you can also use inbuilt speakers 
and microphone if you have these on your computer. 

If you wish to, you can configure two sets of audio devices which can then be 

quickly switched between by pressing the    Speakerphone button in the main 
Allstream PC Communicator Desktop UI.   

Allstream PC Communicator refers to these as Headset Mode and 
Speakerphone Mode, because typically the first mode is configured to use a 
headset and the second, if required, is configured to use external speakers 
and/or an external microphone.   

If you will always use the same set of audio devices, you should configure these 
as the devices to use in Headset mode (even if in fact they are not a headset!).  

This is because “headset mode” is the mode that Allstream PC Communicator 
will use by default. 

For video calls, you can use either an external video camera or a built in camera if 
you have one.   

5.2 Configuring your audio and video equipment 

Before continuing, make sure that any external audio or video devices that you 
wish to use are correctly plugged in to your computer. 

You should now follow the steps described below to ensure that Allstream 
PC Communicator is correctly configured to use your chosen devices. 

• On the Allstream PC Communicator Desktop UI, open the File menu on the 
top-left.

• Click Preferences.
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Figure 7: Allstream PC Communicator Desktop Preferences option 

• On the screen that now appears, click Devices from the menu on the left hand
side.

You will now see the Devices screen. 

Figure 8: Allstream PC Communicator Desktop Devices 

screen 

• Use the Headset Mode tab to select the equipment that you want to use as
your primary audio device(s).  As described above, this may not actually be a
headset but you should still configure your primary equipment on this tab.

• If the displayed Speaker and Microphone are not correct, use the drop-
down to select a different one.

• If you are using a headset, make sure that the correct headset is selected in
both the Speaker and Microphone fields.

• If you are using audio equipment that is connected to your computer using
its USB ports and the selected device is Human Interface Device (HID)-
compliant, the HID Device field specifies that device.
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• Click Setup to assign functions to the device. For example, you can set
the green button on the device so that it answers an incoming call.

• If you want to be able to switch to a second set of audio devices by pressing
the Speakerphone button in the UI, use the Speakerphone Mode tab to select
the devices that you want to use in speakerphone mode.

• If you don’t wish to use speakerphone mode at all, you can Select None
for each of these options.

• Use the Other Devices tab to set up the following optional equipment.

• If you want to make video calls, check that the correct camera is shown, or
use the drop-down to select a different camera model.  This field appears
only if your softphone includes video functionality.

• If you want an additional device to ring when you receive an incoming
call, for example because although you are using a headset for audio you
also have a speaker on your computer that you would like to ring, use the
Ring On field to select the device where you want to hear the phone
ringing.

• Tick the Zero-touch device configuration checkbox so that if you change any
of your audio or video devices, this will automatically be detected and used by
your softphone.

• Click OK to save your changes.

5.3 Testing your audio equipment 

You should now check that your audio equipment is working correctly. 

• Open the Devices page again.

• Click the Test Devices button.

• The Troubleshooting page will now open.
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Figure 9: Testing your audio equipment 

• Test your microphone.

• Ensure that the correct microphone is selected.  If you are using a headset,
check that it is plugged in and has not been muted (most headsets have a
mute button on the headset cable).

• Speak into the microphone.

• You should see confirmation that your microphone works.

• If your microphone is not working, you will see an error message and
some helpful suggestions for resolving the problem.

• Test your speakers.

• Ensure the correct speakers are selected.  If you are using a headset, check
that it is plugged in.

• Press Play.

• Use the slider to adjust the volume.  If you are using a headset, you will
also probably have a volume control on the headset cable.

• If you cannot hear anything, click the No Sound? button for some helpful
suggestions for resolving the problem.
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• If none of these suggestions resolves your problem, you can click the Still
having problems with your device? link to launch the Diagnostics Logging
screen.

• Once you have confirmed everything is working correctly, click Done.
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6 Making calls with Allstream 
PC Communicator Desktop 
You are now ready to use your Allstream PC Communicator Desktop 
softphone to make calls. 

6.1 Making an audio call 

There are several different ways to make a call using Allstream PC 
Communicator Desktop.  The behavior described here is the default behavior.  

You can make some changes to the way in which Allstream PC Communicator 
Desktop places calls using the Preferences menu, as described in section 6.3.  

• Type a phone number into the main dial box on the softphone and press the
Call button.

• You can use the keyboard on your computer, or press  to bring up a dial 
pad on the softphone itself, to enter the number.

• To call someone on your Contacts tab:

• Start typing the contact's name in the search box.

• As you type, Allstream PC Communicator Desktop will 
suggest appropriate contacts.

• Double click on a contact to add them to the dial box.

• Press the Call button

• This will place a call to the number configured as the contact's primary
phone number.

• Find the contact on the Contacts tab, and do one of the following:

• double-click on the contact's name.

• Their name will now appear in the main dial box.  Press the Call
button to make the call.

• As above, this will place a call to the number configured as the
contact's primary phone number.

• right click on the contact's name and select Call from the menu that
appears.

• If the contact has more than one phone number configured on your
Contact list, you can use the  arrow to display all the numbers and
select the one you want to use.  The call is placed immediately.

Figure 10: Calling a contact with more than one phone number 
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6.2 Making a video call 

If you have a camera on your computer, you can make a video call.  (If you do not 
have a camera, you can still receive video calls if the caller is sending video.) 

• To make a call where video is sent as soon as the call is connected:

• When you have entered the name or number of the person you are calling
in the dial box, rather than pressing the Call button, use the drop-down
arrow alongside it and select Video Call.

• If you have right-clicked on a contact to make the call, select Video Call.

• To send video when you are already in an audio call:

• Click the  video icon in the call panel. 

• A red cross will appear on the video icon, as illustrated below.

• Click on the video icon again to stop sending video.

Figure 11: Making a video call 

6.3 Setting your call preferences 

You can make changes to how your Allstream PC Communicator Desktop 
softphone is set up to make calls.  For example, you may want to change the 
configuration so that the softphone makes a call immediately you select a phone 
number, or to always place a video call. 

• Open the File menu, and select Preferences.

• You will now be on the Application page.
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Figure 12: The Application Preferences menu 

• On the General Preferences panel:

• If you want the softphone to start dialing as soon as you have selected a
phone number or contact, rather than having to press the Call button or 
double click on a contact:  

• Tick the Call immediately once a phone number is selected checkbox.

• This will place a call to the contact's main phone number if they have
more than one number configured.

• On the Default Actions panel:

• To change the default action of the Call button (which is to make an audio
call when it's pressed):

• Ensure that the Button field is showing Call.

• Use the Default action drop-down to select Make a video call (so that
video is sent immediately on a call) or Start a conference (so that
every call is a conference call).
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• To change the default action of the Transfer button (which is to make an
immediate call transfer when it's pressed):

• Use the drop-down to ensure that the Button field is showing Transfer.

• Use the Default action drop-down to select Call First (if you want to
call the person you are transferring the call to so that you can check
they are prepared to take the call).

• To change the default action when double-clicking on a contact (which is
to place a telephone call):

• use the drop-down to select IM (so that you send an Instant Message to
your contact ) or E-mail (so that you send an e-mail to your contact).

• When you have made all your changes, click OK to save your changes and
return to the main softphone UI.
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7 Receiving a call through Allstream 
PC Communicator Desktop 
To receive a call, your Allstream PC Communicator Desktop softphone must 
be running. 

• You can minimize your softphone to your taskbar or system tray and still be
able to receive a call.

• To minimize your softphone to your taskbar, press  on the top-right of 
your softphone.

• To minimize your softphone to your system tray, press  on the top-right 
of your softphone.

• You must not close the softphone (by pressing File and then Exit, or Ctrl Q).

• If the softphone is closed or you do not answer it, the call will be sent straight
to your voicemail account (if you have one).

When you have an incoming call: 

• You will hear the sound of a telephone ringing through one or more of your
chosen audio devices (see audio device selection in chapter 5.)

• You will see the call panel on your softphone, showing information about the
call, for example who is calling and whether it is an audio or video call.

• You will also see the Call Alert box on your desktop, unless you have
configured your Preferences to suppress incoming call alerts.

7.1 Answering a call 

You can answer an incoming call using the Call Alert box or the Call Panel on the 
softphone UI. 

Figure 13: Receiving a call  

• Click the Answer button to answer the call.

• If the caller is making a video call to you, you have the option to choose to
answer the call as an audio or video call.

• Click Audio to accept the call as an audio call.  You will not be able to see
the caller's video.
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• Click Video to accept the call as a video call.

• The video window will open on your computer.  You will see the
caller in the large window and yourself in the small window if you
have video calling configured.

• Depending on your call settings, you may need to click the video icon
in the call panel to start sending your video (as described in 6.2).

• You will be able to see the video being sent by the caller, even if you
can't send your own video.

• Click Decline to send the caller directly to your voicemail.

• If you are viewing the softphone UI rather than the Call Alert box, click  to 
forward the call without answering it – you will be prompted to enter the
number of the person you want to forward the call to.

When you are in a call, you can use icons on the softphone UI to carry out various 
actions. 

• Click  to transfer the call – you will be prompted to enter the number of the 
person you want to forward the call to.

• Click  to start, or stop, sending video. 

• Click  to start a conference call or record the call. 

• Press Hold to put the call on hold.

• Press End Call to hang up.

You can use the History tab on the Allstream PC Communicator Desktop UI to 
see a list of the calls you have made and received.   

• Use the drop-down to either display All your calls, or filter on Missed,
Received or Dialed.
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8 Accessing your voicemail 
The Allstream PC Communicator Desktop UI uses the following icon to 

indicate when you have unread voicemails in your Allstream PC account. 

Figure 14: Allstream PC Communicator Desktop Voicemail indicator 

The number in the red circle shows how many unread voicemails you have. 

• Click on the icon to go straight to the Messages & Calls tab on your 

Allstream PC account and see your messages.
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9 Accessing Allstream PC 
Communicator Desktop Help 
Allstream PC Communicator Desktop has an extensive, in-built Help menu that 
you should use to discover how to make the most of your softphone. 

The Help also includes some troubleshooting information, including answers to 
the most frequently asked questions. 

You can access the Help pages by clicking on Help in the top menu bar, and then 
selecting Help.  

Figure 15: Accessing Allstream PC Communicator Desktop Help pages 
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10 Troubleshooting 
Allstream PC Communicator Desktop has its own troubleshooting section 
within the Allstream PC UI.  You can access this by going to the Help menu 
and selecting Troubleshooting.  On this screen, you can  

• check that your audio and video equipment is working correctly

• run tests on your network connection and the quality of the audio

• generate diagnostics logging (when requested by your Support Desk).

10.1 Fixing common problems 

There are a number of things that you can try to resolve common problems when 

you are using Allstream PC Communicator before you contact your Support 
Desk.  If these checks do not resolve the problem, contact your Support Desk. 

10.1.1 Cannot log on or start Allstream PC Communicator 

If you are having difficulty logging on to and starting Allstream PC Communicator: 

• Check that you are logging on using the main phone number you use to access 
your Allstream PC account: you cannot log on to Allstream PC Communicator 
using the number of a secondary mailbox on that account.

• Check that you have an internet connection.

• If you are able to log on to Allstream PC Communicator Desktop but see an 
error message in the client indicating that there might be a problem with your 
internet connection, use the Network tab on the Troubleshooting page and 
select Test Network Connection to run a test on the your internet connection. 
You should take a note of the values that appear on the Connection Test 
screen to pass on to your support desk.

10.1.2 No audio and/or video  

If you get no audio and/or video when making calls, you should carry out the 

following checks within the Allstream PC Communicator Desktop UI: 

• Check that your audio and any video equipment is configured correctly, as
described in section 5.3.

• Use the Audio tab on the Troubleshooting page and select Test Audio Quality
to run a test on the quality of the audio.  You should take a note of the values
that appear on the Audio Test Quality screen to pass on to your support desk.

If this does not resolve the problem, you can use the following instructions to 
check that your audio equipment is configured correctly within Windows.   

These instructions apply to a Windows 7 computer: 
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• Right click the  speaker icon in the system notification area to the bottom 
right of your computer screen.

• Select Playback devices.

• On the Playback tab, check that your chosen audio equipment appears in
the list of devices.

• If a device isn't listed, check that it is connected to your computer and
right click the empty area below the listed devices and select Show
disabled devices – the device should then be listed.

• Some models of headset may by default appear as another 'Speakers'
device. To avoid confusion, you should rename the headset by clicking
on it, selecting Properties and entering an alternative name.  You can
also use this menu to change the icon that is displayed.

• Make sure the correct audio device is selected as the Default Device.

• If you are only using your speakers for audio, select your speakers as
the Default Device.

• If you are also using a headset and want all audio to go through your 
headset, apart from Allstream PC Communicator Desktop ringing for 
an incoming call, select your headset device.

• To set the Default Device, press the arrow next to the Set Default button
and choose the Default Device option.

• If the "Set Default" item is still not grayed-out

• press the arrow again

• choose Default Communications Device.

• Check that your speakers are functioning correctly.

• On the Playback tab, right-click on the speaker.

• Select Properties.

• On the Levels tab, check that the volume is not set to zero and the speaker
isn't muted, where mute is indicated by a red crossed circle on the button 
to the right of the volume. 

• Check that you don't have anything plugged into the 3.5mm headphone
socket on your PC or docking station (as this will mute the PC speaker).

10.1.3 Poor Quality Audio or Video 

If you get poor quality audio or video when making calls, this is most likely due 
to a poor network connection.   
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• Wired connections will generally offer much better connectivity than wireless,
so if you have a choice and are using a wireless connection, you should switch
to wired.

• If you have a laptop with a wired connection and a wireless connection, try
turning off the wireless to check that Windows is not using it by preference.

• If you are on a home wireless network and are a long way from your WiFi
Access Point, you may be able to improve network connectivity by moving
closer.

• If you are on a corporate network, contact your network administrator for
assistance.

10.2 Generating Diagnostics Logging 

If you report a problem with Allstream PC Communicator Desktop to your 
Support Desk, you may be asked to generate some diagnostics in order to help 
the support staff resolve the issue. 

To generate Diagnostics Logging: 

• On the Help menu of the Allstream PC Communicator Desktop UI, 
select Troubleshooting.

• Open the Diagnostics tab.

• Click Start Logging.  The Diagnostics Logging screen appears.

• Find the menu item that most closely describes the error you are seeing, and
use the  expand it.
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Figure 16: Diagnostics Logging screen 

• Select the specific error and click Start Logging.

• You will see a message confirming that logging has started.

• Click Finish to close the Diagnostics Logging screen and return to the
Diagnostics page.

• Click Send Report.

• Click Done to close the window and return to the softphone UI.

The diagnostics will then automatically be sent on for further analysis. 
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A Quick reference information 
Table 1: Quick reference information 

Your phone number 

Your extension 

Code to dial an external number 

Access your phone settings online 

Conferencing phone number 

Conferencing moderator code 

Conferencing participant code 

Conferencing moderator web access http://hostedvoice.integra.net 

Remote access to call forwarding 
number 

Your administrator 

Your administrator's phone number 
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